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1. Introduction 
In this tutorial we’ll show you how to build a C# application to access DB2 via the SOA Gateway. 

2. Prerequisites 
It is assumed that you are running the 3 components, DB2, C# and the SOA Gateway on Windows.  

It is assumed you already have a SOA Gateway server and Control Centre installed. See here for 

more info about installing the SOA Gateway. 

3. Setup 
To build and run C# applications, you will need a Visual Studio IDE. If you do not already have a C# 

IDE installed, we recommend using the Microsoft Visual Studio Express range of products. They can 

be downloaded freely from Microsoft website, packaged for a number of languages, including C#. 

See here for more information about downloading, installing, and configuring VC# Express.  

You will also need a DB2 database. IBM provides a downloadable edition of DB2, called “DB2 

Express-C”. See this link for the DB2 Express-C homepage. Download and install a version of DB2 

Express. 

 

3.1. Populate DB2 Database 
Now that you’ve got DB2 installed, we need to populate it with some demo data. For this we’ll use 

the Risaris Bank Demo, which is available here.  Save this file to “c:\Temp\RisarisBank_db2.sql”. 

¶ Open the DB2 Control Centre under “IBM DB2”, “General Admin Tools” in the Start Menu. 

¶ Right click “All databases” and select “Create Database”, “Standard”. 

¶ Name your new database “RISBANK”. All other options can be left as default, so click 

“Finish”.  

¶ Open a DB2 command shell by typing “db2cmd” in a DOS box.  

¶ From the db2 command shell, change directory to where you downloaded the 

RisarisBank_db2.sql. E.g “cd \temp”. 

¶ Populate the RISBANK database by running the command “db2 -f RisarisBank_db2.sql”. Note 

you may see errors about “SYSTEM.CUSTOMERINFORMATION is an undefined name”. These 

occur because the RisarisBank_db2.sql attempts to drop any existing tables before creating 

new ones. To prove this, you can run the same command again, and the errors will 

disappear.  

¶ You can now return to the DB2 Control Centre and view the newly created tables in the 

RISBANK database.  

3.2. Set up ODBC Access 
The final thing to do with your DB2 Database is to set up an ODBC DSN which will be used by the 

SOA Gateway to access this database.  

Click Start, Control Panel, Administrative Tools, Data Sources (ODBC) 

http://www.risaris.com/documentation/v411/installation/index.htm
http://www.microsoft.com/express/vcsharp/
http://www-306.ibm.com/software/data/db2/express/
http://risaris.com/samples/RisarisBank_db2.sql
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From the resulting screen, choose the “System DSN” Tab. 

Click Add 

From the list of data source drivers, select “IBM DB2 ODBC DRIVER”, and click “Finish”. 

Enter “RisarisBank_db2” as the Data source Name. 

Ensure that the Database Alias is RISBANK, and click “OK”. 

 

 

4. Discovery 
At this stage you’ve got a C# IDE, and a DB2 database with some sample data in it. In this section 

we’ll show you how to create web services from each of the DB2 tables. These web services can be 

used by the C# language (and many others) to give you direct real-time access to your DB2 Data.  

 

4.1. Web Service Creation using the SOA Gateway 
Start your SOA Gateway Control Centre. See here for an introduction to the Control Centre. 

In your servers view, right click the entry which represents your local SOA Gateway Server. Select 

“Create New Web Services”.  

http://www.risaris.com/documentation/v411/gettingstarted/intro.htm
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From the next dialog, choose “DB2 Driver”. If you do not see have a DB2 Driver in the list, see how to 

create one here. 

 

Click Next. 

The next screen gives you the ability to add information about your DSN 

http://www.risaris.com/documentation/v411/admin/ccserver.htm#mod_drivers
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Enter the above information and click Discover. 

The wizard will display all the tables it finds at this (RisarisBank_db2) DSN.  

Look for the tables that are part of the “SYSTEM” schema, and select each of these by checking the 

box. These are the 8 tables we created during the populate step. Once they are all selected, click 

“Import” 

The wizard will create web services from each one of these tables. 

 

 

You’ve just created 8 Web Services from your 8 DB2 Tables! 

 

5. Accessing the WSDL 
Web Service Description Language (WSDL) is a standard, XML-based language that is used to 

describe a Web Service.  
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For each of the 8 web services you’ve created in the previous section, the SOA Gateway provides you 

with a WSDL to describe the Web Service.  The WSDL itself is usually interpreted by a web service 

client, such as C#, but it is useful to know where to find the WSDL for each of your Web Services.  

As WSDL is XML-based, it will open in your browser of choice. To see the WSDL for one of your 

Risaris Bank web services, do the following in your SOA Gateway Control Centre: 

¶ Click on the web service you are interested in, for example the “BRANCH_SYSTEM” web 

service. 

¶ The properties for this web service should appear in your Properties View. If you do not see 

the Properties view, select Window -> Show View -> Other -> General -> Properties and click 

OK. 

¶ In the properties view, there is a link to your WSDL. Click it to open the WSDL in a browser. 

 

http://www.risaris.com/documentation/v241/admin/cctop.htm
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You can view the WSDL for the other web services by clicking the link from their properties view.  

This WSDL is the starting point for using Web Services, and can be used time and again By different 

web service clients.  

 

6. Accessing the Web Service with C# 
C# is an object orientated programming language from Microsoft as part of the .NET initiative. Its 

syntax is loosely based on C++, while borrowing other aspects from programming languages such as 

Java.  

We will use C# to build an application which accesses our new Risaris Bank Web Services via the 

WSDL.  

6.1. Initial Setup 
Start Microsoft Visual C# Express and create a New Windows Application Project named Risaris Bank 

Demo DB2. 

 

 

Depending on which version of Visual Studio you are using, choose one of the following sections. 

 

6.1.1. Setup for Visual C# 2005 
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In the Solution Explorer, right click References, and select Add Web Reference 

 

 

 

We want to use 2 of the Web Services we’ve created, CUSTOMERINFORMATION_SYSTEM and the 

CURRENTACCOUNT_SYSTEM web services.  

¶ Copy the URL of this web services WSDL into the URL box.  

¶ Click Go.  

¶ Once the WSDL has been loaded, change the Web Service Reference Name to CustomerInfo 

¶ Click Add Reference 
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Do the same for the CURRENTACCOUNT_SYSTEM WSDL, except change the Web Reference name to 

CurrentAccount 

 

 

You should now have 2 new Web References loaded into your Solution Explorer 
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6.1.2. Setup for Visual C# 2008 

 

Right-click your project and select “Add Service Reference” 

 

 

We want to use 2 of the Web Services we’ve created, CUSTOMERINFORMATION_SYSTEM and the 

CURRENTACCOUNT_SYSTEM web services.  

¶ Copy the URL of this web services WSDL into the Address box.  

¶ Click Go.  

¶ Once the WSDL has been loaded, change the Namespace to CustomerInfo 

¶ Click OK 
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Now do the same for the CURRENTACCOUNT_SYSTEM WSDL, except change the Web Reference 

name to CurrentAccount 
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You should now have 2 new Service References loaded into your Solution Explorer 

 

 

6.2. Designing the Form 
In this section we’ll add the necessary controls to our Form. Before you start ensure, that you are in 

the Designer View (View -> Designer), and that you have the control Toolbox available (View-

>Toolbox) 
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I’ve used the following controls in this Form 

¶ GroupBox (Customer Info and Current Account Info ) 

¶ Label (Customer Number, Current Account Balance, Current Account Overdraft) 

¶ TextBox (at each label) 

¶ Button (x2) 

¶ ListView 

The ListView is the only control that needs additional setup. 

When you add this control, edit the “Columns” property. Add 8 members, each with the following 

Text property. 

V CustomerNumber 

V FirstName 

V Surname 

V AddressLine1 

V AddressLine2 

V City 

V ZipCode 

V DOB 

You will notice that these fields match the columns that appear on the CustomerInfomation table in 

DB2.  
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Note that I haven’t changed any of the default design names that the C# designer has given me. 

Therefore from the top of the form the design names of the text boxes are textBox1, textBox2, 

textBox3. Similarly, the buttons are named button1 and button2, and the list view is called listView1.  

You may change these to what ever you wish, but be aware your C# code in the next section will 

have to be cognisant of this! 

 

 

 

 

 

 

textBox1 button1 

listView1 
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6.3. Writing the setup code 
Now that the Form controls have been added, we need to write the code to call our Web Services 

when the buttons are clicked. 

Switch to your Code view, by clicking View->Code 

After the “using” statements, enter the following  

using System.Globalization;  

using  Risaris_Bank_Demo _DB2.CurrentAccount;  

using  Risaris_Bank_Demo _DB2.CustomerInfo;  

These statements include your 2 Web References you added earlier. 

That should be all the housekeeping we need to call our Web Services. Now we get to the stage of 

writing the code that is run when a user clicks a button. 

6.4. Event Handing Code: Search Button 
Switch back to your Designer view, and double-click the “Search” button in your Form. Your IDE will 

switch over to the code view, and a new member function to handle the button click will be created. 

When this button is clicked, we want to take the contents of textBox1 (which is the Customer ID), 

and send this to our Customer Information web service. The web service should return the required 

customer information for that ID.  

We break that customer information down into its respective parts, and then add that to our 

listView.  

The code differs slightly between VC# 2005 and VC# 2008, choose the one that corresponds to your 

version. 

 

6.4.1. Code for VC# 2005 

 

private  void  button1_Click( object  sender, EventArgs  e)  

{  

// create a new C# instance of the Web Service  

CUSTOMERINFORMATION_SYSTEMRootService service =  

new CUSTOMERINFORMATION_SYSTEMRootService();  

 

// clear out any existing items from listView  

listView1.Items.Clear();  

 

// create a new key value that we send to the web service  

CUSTOMERINFORMATION_SYSTEMGroupKeyType key =  

new CUSTOMERINFORMATION_SYSTEMGroupKeyType();  

 

// set the CustomerNumber to the contents of textBox1  

key.CUSTOMERNUMBER = textBox1.Text;  

 

// set up a variable to store the result  

CUSTOMERINFORMATION_SYSTEMRootElementType results;  
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try  

{  

// call the "list" operation of web service!  

results = service.list(key);  

}  

catch  ( Exception  exp)  

{  

// an error occured ï  

// the web service will report the error  

// as part of the exception.  

MessageBox .Show(exp.Message, "Error" ,  

                MessageBoxButtons .OK, MessageBoxIcon .Exclamation);  

                return ;  

}  

 

// Add the results to our list view  

for  ( int  i = 0;  

i != results.CUSTOMERINFORMATION_SYSTEMRoot.Length; i++)  

{  

// Store each customer found  

// in a local variable for ease of access.  

CUSTOMERINFORMATION_SYSTEMGroupType customer =  

results.CUSTOMERINFORMATION_SYSTEMRoot[i];  

 

// create a new row  

ListViewItem  lv =  

new ListViewItem (customer.CUSTOMERNUMBER);  

 

// add the rest of the items in the row  

lv.SubItems.Add(customer.FIRSTNAME);  

lv.SubItems.Add(customer.SURNAME);  

lv.SubItems.Add(customer.ADDRESSLINE1);  

lv.SubItems.Add(customer. ADDRESSLINE2);  

lv.SubItems.Add(customer.CITY);  

lv.SubItems.Add(customer.POSTCODE);  

lv.SubItems.Add(customer.DATEOFBIRTH);  

 

// add the row to the listView  

listView1.Items.Add(lv);  

listView1.View = View .Details;  

listView1.FullRowSelect = true ;  

}  

}  

 

6.4.2. Code for VC# 2008 

 

private  void  button1_Click( object  sender, EventArgs  e)  

        {  

            // create a new C# instance of the Web Service  

            CUSTOMERINFORMATION_SYSTEMRootPortTypeClient  service =  

                new CUSTOMERINFORMATION_SYSTEMRootPortTypeClient ();  

 

            // clear out any existing items from listView  

            listView1.Items.Clear();  

 

            // create a new key value that we send to the web service  
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            CUSTOMERINFORMATION_SYSTEMGroupKeyType  key =  

            new CUSTOMERINFORMATION_SYSTEMGroupKeyType();  

 

            // set the CustomerNumber to the contents of textBox1  

            key.CUSTOMERNUMBER = textBox1.Text;  

 

            // create empty header element  

            CUSTOMERINFORMATION_SYSTEMGroupHeader header = null ;  

 

            // set up a variable to store the result  

            CUSTOMERINFORMATION_SYSTEMRootElementType results;  

 

            try  

            {  

                // call the "list" operation of web service!  

                results = service.list( null , ref  header, key);  

            }  

            catch  ( Exception  exp)  

            {  

                // an error occured ï  

                // the web service will report the error  

                // as part of the exception.  

                MessageBox .Show(exp.Message, "Error" ,  

                    MessageBoxButtons .OK, MessageBoxIcon .Exclamation);  

                return ;  

            }  

 

            // Add the results to our list view  

            for  ( int  i = 0;  

            i != results.CUSTOMERINFORMATION_SYSTEMRoot.Length; i++)  

            {  

                // Store each customer found  

                // in a local variable for ease of access.  

                CUSTOMERINFORMATION_SYSTEMGroupType customer =  

                results.CUSTOMERINFORMATION_SYSTEMRoot[i];  

 

                // create a new row  

                ListViewItem  lv =  

                new ListViewItem (customer.CUSTOMERNUMBER);  

 

                // add the rest of the items in the row  

                lv.SubItems.Add(customer.FIRSTNAME);  

                lv.SubItems.Add(customer.SURNAME);  

                lv.SubItems.Add(customer.ADDRESSLINE1);  

                lv.SubItems.Add(customer.ADDRESSLINE2);  

                lv.SubItems.Add(customer.CITY);  

                lv.SubItems.Add(customer.POSTCODE);  

                lv.SubItems.Add(customer.DATEOFBIRTH);  

 

                // add the row to the listView  

                listView1.Items.Add(lv);  

                listView1.View = View .Details;  

                listView1.FullRowSelect = true ;  

            }  

        }  
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6.5. Event Handling Code: Account Details Button 
Now that we have the ability to call a web service to get the customer information, we can also call a 

web service which will find the Current Account details for that customer.  

To do this, we will take the Customer ID of the row selected in the list View, and call our 

CurrentAccount web service with this ID. This will give the user the ability to select a customer from 

a list, and then see what balances their current account has.  

Again, we switch back to our Design view, and double-click the “Get Account Details” button.  A new 

member function called “button2_click” will be created in the code view.  

Again, the code differs slightly between versions. Choose the suitable one from below 

 

6.5.1. Code for VC# 2005 

 

private  void  button2_Click( object  sender, EventArgs  e)  

{  

// create a new C# instance of the CurrentAccount web service  

CURRENTACCOUNT_SYSTEMRootService service =  

new CURRENTACCOUNT_SYSTEMRootService();  

 

// get the currrently selected Customer ID  

String  currentCustomerId =  

listView1.SelectedItems[0].SubIte ms[0].Text;  

 

// create a new key value that we send to the web service  

CURRENTACCOUNT_SYSTEMGroupKeyType key =  

new CURRENTACCOUNT_SYSTEMGroupKeyType();  

 

// set the CustomerNumber to the CID  

key.CUSTOMERNUMBER = currentCustomerId;  

 

// set up a variable to store the result  

CURRENTACCOUNT_SYSTEMRootElementType results;  

 

try  

{  

// call the "get" operation of the web service!  

results = service.list(key);  

}  

catch  ( Exception  exp)  

{  

// an error occured ï  

// the web service will report the  

// error as part of the exception.  

MessageBox .Show(exp.Message, "Error" ,  

                MessageBoxButtons .OK, MessageBoxIcon .Exclamation);  

                return ;  

}  

 

// Now put the results of the web service  

// into the Balance and Overdraft text boxes  

float  bal =  

            f loat .Parse(results.CURRENTACCOUNT_SYSTEMRoot[0].BALANCE,  
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NumberStyles .Currency) / 100;  

float  od =  

           float .Parse(results.CURRENTACCOUNT_SYSTEMRoot[0].OVERDRAFTLIMIT,  

                    NumberStyles .Currency) / 100;  

 

textBox2.Text = bal.ToString();  

textBox3.Text = od.ToString();  

}  

 

6.5.2. Code for VC# 2008 

 

private  void  button2_Click( object  sender, EventArgs  e)  

        {  

            // create a new C# instance of the CurrentAccount web service  

            CURRENTACCOUNT_SYSTEMRootPortTypeClient  service =  

                new CURRENTACCOUNT_SYSTEMRootPortTypeClient ();  

 

            // get the currrently selected Customer ID  

            String  currentCustomerId =  

            listView1.SelectedItems[0].SubItems[0].Text;  

 

            // create a new key value that we send to the web service  

            CURRENTACCOUNT_SYSTEMGroupKeyType key =  

            new CURRENTACCOUNT_SYSTEMGroupKeyType();  

 

            // set the CustomerNumber to the CID  

            key.CUSTOMERNUMBER = currentCustomerId;  

 

            // c reate empty header element  

            CURRENTACCOUNT_SYSTEMGroupHeader header = null ;  

 

            // set up a variable to store the result  

            CURRENTACCOUNT_SYSTEMRootElementType results;  

 

            try  

            {  

                // call the "get" operation of the web service!  

                results = service.list( null ,  ref  header, key);  

            }  

            catch  ( Exception  exp)  

            {  

                // an error occured ï  

                // the web service will report the  

                // error as part of the exception.  

                MessageBox .Show(exp.Message, "Error" ,  

                                MessageBoxButtons .OK, 

MessageBoxIcon .Exclamation);  

                return ;  

            }  

 

            // Now put the results of the web service  

            // into the Balance and Overdraft text boxes  

            float  bal =  

                        

float .Parse(results.CURRENTACCOUNT_SYSTEMRoot[0].BALANCE,  

            NumberStyles .Currency) / 100;  

            float  od =  
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float .Parse(results.CURRENTACCOUNT_SYSTEMRoot[0].OVERDRAFTLIMIT,  

                                NumberStyles .Currency) / 100;  

 

            textBox2.Text = bal.ToString();  

            textBox3.Text = od.ToString();  

        }  

 

6.6. Building the Code 
You can compile the code by hitting F6, or Build -> Build Solution. 

Hopefully, all is well, but in the case of errors try the following: 

¶ Obviously misspellings are often the cause of compilation errors. Ensure that all object 

names, and variable names are spelt correctly. 

¶ The C# has a neat trick where you can type the first few letters of an object, and by hitting 

Control + Space, it will bring up the suggested object names. For names starting with “CU”, 

such as “CUSTOMERINFORMATION” or “CURRENTACCOUNT”, try typing this and hitting 

Control + Space. It may give you an indication of a misspelt object name. 

¶ Similarly, if you need the name of a member of an object, type the object name, followed 

by a dot (“.”) and Control+Space. The list of available proposals should appear. 

 

6.7. Running the code 
By hitting F5 or Debug -> Start Debugging, you can run your code. In the Customer Number text box, 

you may enter * and hit the Search button to call the Customer Information web service and get a 

list of all the customers in the CustomerInformation table.  

From the resultant list, select the record you are interested in, and hit Get Account Details. This will 

call CurrentAccount web service to retrieve the current account balances for this customer.  

If you hit problems, you may wish to debug your code by adding breakpoints in your code. See the 

IDE documentation for further information.  

7. Conclusion 
This tutorial shows how to access DB2 from C# using the SOA Gateway. As you can see, you have 

built a powerful application that uses Web Services to retrieve information in real-time. 

8. Appendix 

Form1.cs for VC# 2005  
 

Code available here 

http://www.risaris.com/tutorials/db2viacsharp/Form1_2005.cs
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Form1.cs for VC# 2008 
 

Code available here 

 

 

 

 

http://www.risaris.com/tutorials/db2viacsharp/Form1_2008.cs

